
 

 

บทที่ 3 วธีิการศึกษา และวเิคราะห์ข้อมูล 

 
การด าเนินงานโครงงาน “เกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็ก
อายุ 6–8 ปี” ผูจ้ดัท าโครงงานไดก้ าหนดกระบวนการศึกษาอย่างเป็นขั้นตอนและเนน้เร่ืองประโยชน์
ของโครงงานต่อกลุ่มเป้าหมายเป็นหลกั เร่ิมจากการก าหนดประชากรและกลุ่มตวัอยา่ง ตลอดจนการ
ก าหนดเคร่ืองมือท่ีใช้ศึกษาโครงงาน กระบวนการต่อมาเป็นส่วนของการสร้างเคร่ืองมือท่ีใช้ศึกษา 
ได้แก่ เกม และแบบประเมินต่างๆ จากนั้นน าเคร่ืองมือท่ีได้ไปประเมินโดยผูเ้ช่ียวชาญและกลุ่ม
ตวัอยา่ง กระบวนการสุดทา้ยคือ การน าผลการประเมินมาวเิคราะห์ เพื่อหาผลลพัธ์วา่โครงงานดงักล่าว
มีประโยชน์ตามท่ีไดค้าดหมายไวห้รือไม่ โดยใชก้ารค านวณค่าทางสถิติ 

  

3.1 ประชากรและกลุ่มตวัอย่าง 

การศึกษาโครงงานในคร้ังน้ี ผูจ้ดัท าโครงงานใชป้ระชากรและกลุ่มตวัอยา่ง ดงัน้ี 

 

3.1.1 ประชากร 

ประชากรท่ีใชใ้นโครงงานน้ี คือ เด็กระดบัชั้นประถมศึกษาปีท่ี 1–3 (อาย ุ6–8 ปี) 

 

3.1.2 กลุ่มตัวอย่าง  

กลุ่มตวัอยา่งท่ีใชใ้นการศึกษาในคร้ังน้ี นกัเรียนระดบัชั้นประถมศึกษาปีท่ี 3 โรงเรียนนาหลวง แขวง
บางมด เขตทุ่งครุ กรุงเทพมหานคร จ านวน  10 คน (ห้องเด็กเก่ง 5 คน และห้องเด็กอ่อน 5 คน)  ดว้ย
วธีิการเลือกตวัอยา่งแบบเจาะจง (Purposive Sampling) 
 

3.2 เคร่ืองมือที่ใช้ในการศึกษา 
การด าเนินการศึกษาโครงงานในคร้ังน้ี ผูจ้ดัท าโครงงานก าหนดเคร่ืองมือท่ีใชใ้นการศึกษาดงัน้ี 

 
1. เกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอายุ 6–8 ปี (แบบ
Offline) 
2. เคร่ืองมือท่ีใชใ้นการประเมินโครงงาน มีดงัน้ี 
 1) แบบประเมินโดยผูเ้ช่ียวชาญในการสร้างเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้
วทิยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอาย ุ6–8 ปี 
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2) แบบทดสอบความรู้ทางวิทยาศาสตร์ เร่ืองสัตว์ โดยผู ้จ ัดท าโครงงานจัดท าเพื่อหา
พฒันาการของกลุ่มตวัอยา่งในการเล่นเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์
ส าหรับเด็ก อาย ุ6–8 ปี 

3) แบบประเมินความพึงพอใจเพื่อหาระดบัความพึงพอใจของกลุ่มตวัอย่างในการเล่นเกม
ผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วทิยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอาย ุ6–8 ปี 

 

3.3 ขั้นตอนการสร้างเคร่ืองมือ 
 

3.3.1 ขั้นตอนการสร้างเกมผจญภัย 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว์ 
ส าหรับเด็กอายุ 6–8 ปี 

ผูจ้ดัท าโครงงานไดก้ าหนดขั้นตอนการสร้างเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง 
สัตว ์ส าหรับเด็กอาย ุ6–8 ปี ทั้งหมด 3 ขั้นตอน 

1) ขั้นตอนการเตรียมงาน 
2) ขั้นตอนการสร้างงาน 
3) ขั้นตอนหลงังานเสร็จสมบูรณ์  

 
3.3.1.1 ข้ันตอนการเตรียมงาน (Pre–Production) 

1)  ศึกษาขอ้มูล ผูจ้ดัท าโครงงานได้มีความคิดวา่จะท าโครงงานเก่ียวกบัเกมผจญภยั 2 มิติ ซ่ึง
ผูจ้ดัท ามีความถนดั จากท่ีมาและความส าคญัท าให้เลือกท าเกมเพื่อส่งเสริมความรู้วิทยาศาสตร์ โดย
กลุ่มตวัอยา่งเป็นเด็กอายุ 6–8 ปี เม่ือไดห้วัขอ้โครงงานแลว้ ผูจ้ดัท าโครงงานจึงเร่ิมศึกษาลกัษณะของ
กลุ่มตวัอยา่งเพิ่มเติมจากหนงัสือ อินเทอร์เน็ต และอาจารยท่ี์ปรึกษา ท าให้ทราบขอ้มูลในเบ้ืองตน้ จาก
การสืบคน้ขอ้มูลขอบเขตเน้ือหากลุ่มสาระการเรียนรู้วิทยาศาสตร์ ส าหรับนกัเรียนชั้นประถมศึกษา
ตอนตน้ พบวา่บทเรียนเก่ียวกบัความรู้เร่ืองสัตว ์เป็นเน้ือหาท่ีมีอยูใ่นรายวิชาพื้นฐานของนกัเรียนชั้น
ประถมศึกษาตอนตน้  
 
 2) วเิคราะห์ขอ้มูล และออกแบบเกม เม่ือน าขอ้มูลท่ีไดม้าพิจารณา และน าไปปรึกษาอาจารยท่ี์
ปรึกษาแลว้ไดข้อ้สรุปวา่ เกมท่ีสร้างข้ึน ใชเ้พื่อส่งเสริมความรู้เพิ่มเติมวิชาวิทยาศาสตร์ เร่ืองสัตว ์โดย
ใช้เกมผจญภยั 2 มิติเพื่อให้ความรู้ เร่ืองสัตว์ ในแต่ละสถานท่ี โดยใช้เกมให้มีปฎิสัมพนัธ์กบัเด็ก
เพื่อให้เด็กเพลิดเพลินไปกบัเกมและให้ความรู้ไปพร้อมๆกนั เด็กจะไดท้บทวนความรู้ท่ีไดจ้ากสมุด
บนัทึกพร้อมรูปภาพประกอบ ในส่วนของเน้ือหาจะอา้งอิงจากหนงัสือชุดความรู้เบ้ืองตน้ส าหรับเด็ก
(ขอ้มูลอยูใ่นภาคผนวก ข.)  
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เกมผจญภยั 2 มิติ น้ีมีช่ือวา่ “Magic Zoo มหศัจรรยส์ัตวก์ูโ้ลก” ผูเ้ล่นจะสวมบทบาทเป็นตวัละคร
สมมติ และมีสิทธิในการเลือกสัตวว์ิเศษได ้1 ตวั จากนั้นผูเ้ล่นและสัตวว์ิเศษจะตอ้งไปช่วยเหลือสัตว์
ตามเกาะต่างๆ แต่ละเกาะจะมีสัตวป์ระจ าเกาะซ่ึงมีหนา้ท่ีบอกภารกิจ ให้ผูเ้ล่นช่วยเหลือและรวบรวม
ความรู้จากสัตวท่ี์ไดช่้วยเหลือไวใ้นเกาะนั้นๆ เม่ือผูเ้ล่นท าส าเร็จ ผูเ้ล่นจะได ้เหรียญความรู้และสัตว์
วิเศษของผูเ้ล่นจะเจริญเติบโต และผูเ้ล่นจะตอ้งไปตอบค าถามเพื่อทดสอบความรู้ท่ีไดม้าของแต่ละ
เกาะ สุดทา้ยผูเ้ล่นสามารถทบทวนความรู้ท่ีไดม้าทั้งหมดจากสมุดบนัทึก ซ่ึงมีรายละเอียด ดงัน้ี 
 
 2.1 รูปแบบการเล่น เป็นเกมผจญภยัท่ีให้ กลุ่มตวัอย่างได้ส ารวจสภาพแวดล้อมของ
สถานท่ีและสัตวใ์นแต่ละเกาะโดยใชภ้ารกิจเป็นตวัก าหนดเพื่อให้กลุ่มตวัอยา่งได ้รู้จกัสัตวท่ี์อาศยัอยู่
ในสถานท่ีนั้นจริงๆก่อน จากนั้นจะใหก้ลุ่มตวัอยา่งไดร้วบรวมความรู้ของสัตวช์นิดนั้นๆ ซ่ึงจะข้ึนตน้
ดว้ยค าวา่ “รู้หรือไม่  ท าไม… ” ผา่นภาพและเสียงประกอบค าบรรยาย เพื่อดึงดูดความสนใจให้ กลุ่ม
ตวัอยา่งไดฟั้งและอ่านตาม 
 
 2.2 เน้ือหาของเกม ผูจ้ดัท าได้สร้างจุดเร่ิมตน้ของเกม โดยเร่ิมจาก การเล่าเร่ืองจากใน
หนงัสือท่ีบรรยายถึง ดินแดนแสนสุข แต่ปัจจุบนัไดถู้กปีศาจแห่งความละโมบเขา้ยึดครองดินแดน
แห่งน้ีจน ธรรมชาติ คนและสัตว ์เดือดร้อน ท าให้เกิดการผจญภยัของผูก้ลา้และสัตวว์ิเศษเกิดข้ึน เพื่อ
ช่วยกนัฟ้ืนฟูธรรมชาติของดินแดนแห่งน้ีให้กลบัคืนมา เม่ือเขา้สู่หนา้หลกัของเกม จะมีค าอธิบายถึง
ส่ิงท่ีจะตอ้งท าต่อไปเพื่อใหเ้กมด าเนินเร่ืองไดต่้อไป 
 
 2.3 การน าเสนอ การผจญภยัของผูก้ลา้และสัตว์วิเศษน้ี ผูเ้ล่นจะตอ้งเขา้ไปช่วยเหลือสัตว์
ในแต่ละเกาะและรวบรวมความรู้ของสัตวใ์นเกาะนั้นๆ มา ซ่ึงวธีิการน าเสนอจะแตกต่างกนัไปตามแต่
ละเกาะ ดงัน้ี 
 
      1) เกาะแห่งทอ้งทะเล ผูเ้ล่นตอ้งรวบรวมฟองอากาศทั้งหมด  8 ฟอง ท่ีกระจายอยูต่ามท่ี
ต่างๆของทอ้งทะเล จากนั้นผูเ้ล่นจะตอ้งพาลูกสัตวท่ี์พลดัพรากจากแม่สัตวก์ลบัไปหาแม่สัตวท์ั้งหมด 
7 ตวั และสุดทา้ยผูเ้ล่นจะตอ้งรวบรวมความรู้จากสัตวท์ะเล ทั้งหมด 7 ตวัน้ีโดยมีเหรียญความรู้เป็นขอ้
แลกเปล่ียนในการสะสม และผา่นไปยงัเกาะต่อไป 
 
      2) เกาะแห่งผืนป่า ผูเ้ล่นจะต้องไปช่วยเหลือสัตว์ต่างๆ ท่ีถูกขงัอยู่ในกรงออกมา 
จากนั้นผูเ้ล่นจะตอ้งรวบรวมความรู้จากสัตวป่์า ทั้งหมด 7 ตวัน้ีโดยมีเหรียญความรู้เป็นขอ้แลกเปล่ียน
ในการสะสม  
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 2.4 กลไกตรรกะของเกม เกมน้ีมีระบบการท างานแบ่งเป็นระบบต่างๆ ดงัน้ี 
       1) ระบบเลือกตวัละคร ผูเ้ล่นจะตอ้งเลือกตวัละคร 2 ตวั นัน่คือ ตวัละครหลกั จะอยูใ่น
รูปแบบ ตวัละครเด็กผูห้ญิง และตวัละครเด็กผูช้าย ส่วนสัตวว์เิศษ จะมีใหเ้ลือกทั้งหมด 2 ตวั 
       2) ระบบบนัทึกเกมผูเ้ล่นสามารถท าการบนัทึกเกมได ้โดยกรอก ช่ือเลือกตวัละครหลกั
ขอ้มูลจะถูกบนัทึกลงเคร่ือง ในระหว่างการเลือกตวัละครสัตวว์ิเศษ ขอ้มูลจะถูกบนัทึกการเล่นแบบ
อตัโนมติัเป็นระยะๆ 
       3) ระบบการเล่นเกมมีทั้งหมด 2 เกาะ  
       4) ระบบแสดงภาพเคล่ือนไหว ภาพเคล่ือนไหวจะเกิดข้ึนเม่ือผูเ้ล่นมีการปฏิสัมพนัธ์
กบัเกม เช่น การใชเ้มาส์ หรือคียบ์อร์ด ในการควบคุมตวัละคร และการกดปุ่ม 
       5) ส่วนค าถาม คือ ส่วนประกอบหลกัของเกมท่ีผูเ้ล่นตอ้งทดสอบความรู้เพื่อให้ผา่น
ไปฉากต่อไป 
       6) ระบบทบทวนความรู้ การรวบรวมความรู้ในแต่ละเกาะจะถูกเก็บอยูใ่นสมุดบนัทึก
ท่ีมีช่ือวา่ “บนัทึกการเดินทาง” หลงัจากท่ีผูเ้ล่นไดช่้วยเหลือสัตวใ์นเกาะนั้นส าเร็จแลว้ 
 
 2.5 ส่ิงท่ีผูเ้ล่นสามารถท าได ้
       1) หนา้แรกของเกมผูเ้ล่นสามารถ กด Start เพื่อเร่ิมเกม หรือกด Exit เพื่อออกจากเกม 
       2) หนา้เลือกตวัละครหลกั ผูเ้ล่นสามารถ พิมพช่ื์อ เลือกตวัละครชาย-หญิง และผูเ้ล่น
สามารถโหลดขอ้มูลท่ีเคยเล่นมาแลว้ หรือลบขอ้มูลท่ีเคยเล่นมาแลว้ไดเ้ช่นกนั 
       3) ในหนา้หลกัของเกม ผูเ้ล่นสามารถเลือก หนงัสือ, แผนท่ี, ไข่, ปุ่มช่วยเหลือ, เครดิต 
และ ออกจากเกม 
       4) หนา้เลือกตวัละครสัตวว์ิเศษ ผูเ้ล่นสามารถเลือกตวัละครในการเล่นเกมในแต่ละ
คร้ัง ไดเ้พียงตวัเดียว 
       5) เม่ือผูเ้ล่นท าภาระกิจช่วยเหลือสัตวแ์ละรวบรวมความรู้ไดค้รบแลว้ ผูเ้ล่นจะตอ้งไป
ตอบค าถามหลงัจากรวบรวมความรู้เสร็จในแต่ละเกาะก่อน ผูเ้ล่นถึงสามารถเลือกไปยงัเกาะต่อไปได ้
หรือกลบัไปหนา้หลกัก็ได ้ระบบจะท าการเก็บขอ้มูลอตัโนมติั 
       6) หลงัตอบค าถามเสร็จคะแนนจะถูกบนัทึก และเม่ือผูเ้ล่นตอบค าถามไดค้รบทั้งหมด 
2 ชุด ระบบจะแสดงคะแนนสรุปทั้งหมด  
       7) เม่ือผูเ้ล่นไดร้วบรวมความรู้ส าเร็จในแต่ละเกาะ ความรู้ทั้งหมดจะถูกเก็บไวใ้นสมุด
บนัทึก ผูเ้ล่นสามารเขา้ไปทบทวนความรู้ท่ีไดม้าก่อนตอบค าถามหรือหลงัตอบค าถามก็ได ้
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 3) เตรียมความพร้อมดา้นอุปกรณ์ และดา้นการท าส่ือ 
 3.1 ดา้นอุปกรณ์ ประกอบดว้ย ฮาร์ดแวร์ (Hardware) และซอฟตแ์วร์ (Software) ฮาร์ดแวร์ 
ไดแ้ก่ เคร่ืองคอมพิวเตอร์ ท่ีมีหน่วยความจ าหลกัท่ีมีความเร็วมากกวา่ 512 เมกาไบท ์และพื้นท่ีภายใน
อุปกรณ์ท่ีใชเ้ก็บขอ้มูลหรือโปรแกรม (Hard disk) ตั้งแต่ 300 เมกาไบท ์เคร่ืองสแกนเนอร์ ใชส้ าหรับ
น าภาพท่ีวาดในกระดาษเขา้เคร่ืองคอมพิวเตอร์ ไมโครโฟน ใช้ส าหรับบนัทึกเสียงพากยเ์ขา้เคร่ือง
คอมพิวเตอร์ ซอฟต์แวร์ ไดแ้ก่ โปรแกรมอะโดบี อิลลสัสเตเตอร์ ซีเอสห้า ใช้ส าหรับงานสร้างภาพ
การ์ตูน ฉาก และองค์ประกอบต่างๆ ของการ์ตูน,โปรแกรมอะโดบี แฟลช ซีเอสห้า  ใช้ส าหรับงาน
เคล่ือนไหวภาพการ์ตูน, โปรแกรมเนโร เวฟอิดิเตอร์ (Nero Wave Editor) ใชส้ าหรับบนัทึกเสียงพากย ์
และโปรแกรมซาวดฟ์อร์ด ออดิโอ สตูดิโอ 9.0 (Sound Forge Audio Studio 9.0) ใชส้ าหรับแปลงไฟล์
เสียง ใชส้ าหรับตดัต่อเสียง   
 
 3.2 ดา้นการท าเกม ประกอบดว้ย การฝึกฝนวาดภาพสัตว ์และการใช้โปรแกรมประยุกต์
การฝึกฝนวาดภาพสัตว ์เร่ิมจากการฝึกวาดโครงแบบกา้นไมขี้ดในการร่างส่วนศีรษะและกระดูกสัน
หลงั การใช้วงกลมในการกะสัดส่วนของศีรษะและล าตวั การวาดขาสัตวโ์ดยใช้เส้นโคง้รูปตวัเอส 
รวมถึงการวาดลกัษณะท่าทางของสัตวใ์นอิริยาบถต่างๆ เม่ือสามารถวาดภาพสัตวเ์ลียนแบบของจริง
ไดแ้ลว้จะน าพื้นฐานการวาดภาพสัตวข์องจริงมาใชใ้นการวาดภาพการ์ตูนดงัรูปท่ี 3.1 

 
 
 

  
 

 
 

รูปที ่3.1 ภาพสัตวโ์ครงร่างไมขี้ดไฟ [22] 
 

การใช้โปรแกรมประยุกต์ เร่ิมจากพื้นฐานการใช้เคร่ืองมือต่างๆ ท่ีมีอยู่ในโปรแกรมให้คล่อง ทราบ
ประโยชน์ของเคร่ืองมือแต่ละชนิด ท าให้ใช้เคร่ืองมือให้ท างานไดต้ามตอ้งการ นอกจากน้ียงัศึกษา
เทคนิคพิเศษต่างๆ เพิ่มเติม จากหนงัสือหรือผูเ้ช่ียวชาญ เพื่อใหง้านตรงกบัความตอ้งการมากท่ีสุด  
 
 4) เขียนแผนภาพล าดบัเหตุการณ์หลงัจากทราบลกัษณะรวมของงานแลว้ ต่อไปจะเป็นการ
ก าหนดรายละเอียดของเกม ซ่ึงใชก้ารวาดล าดบัภาพตั้งแต่หนา้แรกของเกม เขียนรายละเอียดของภาพ 
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ตรงจุดน้ีจะเป็นการบอกรายละเอียดของเกมในแต่ละหนา้ วา่มีปุ่มอะไรบา้ง แต่ละปุ่มเช่ือมโยงไปหนา้
ไหนไดบ้า้ง แต่ละหนา้ตอ้งการให้ผูเ้ล่นท าอะไรในแบบคร่าวๆก่อน (แผนภาพล าดบัเหตุการณ์อยูใ่น
ภาคผนวก ก.) 
 

 
 
 
 
 
 
 
 
 
 
 
 
  

รูปที ่3.2 แผนภาพล าดบัเหตุการณ์เกม Magic-Zoo ในส่วนของหนา้แรกและเขา้สู่หนา้หลกั 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.3 แผนภาพล าดบัเหตุการณ์เกม Magic-Zoo ในส่วนของหนงัสือ 
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 5) ออกแบบตวัละครและฉาก ภาพรวมของตวัละครในเกมตอ้งมีความน่ารัก สดใส สามารถ
ดึงดูดความสนใจเด็กๆได ้ซ่ึงตวัละครหลกัของเกมน้ี คือ ตวัละครเด็กผูห้ญิง, เด็กผูช้าย และสัตวว์เิศษ  
ซ่ึงตวัละครเด็ก จะออกแบบโครงสร้างและรายละเอียดให้ใกลเ้คียงกบักลุ่มตวัอย่าง เพื่อเป็นตวัละคร
สมมติ ท่ีเสมือนวา่เด็ก เป็นตวัละครนั้นจริงๆ  ส่วนสัตวว์ิเศษนั้นก าหนดรูปแบบให้อยูใ่นรูปของสัตว ์
แต่มีการดดัแปลง เพื่อใหต้วัละครมีความน่าสนใจ ส่วนตวัละครสัตวอ่ื์นๆ จะใชล้กัษณะเฉพาะตวัของ
สัตวท่ี์เป็นจุดเด่นน ามาออกแบบเพื่อให้ภาพท่ีไดมี้ความชดัเจน และสวยงาม ขั้นตอนการท าเร่ิมจาก
การร่างรูปคร่าวๆ จากนั้นคดัเลือกแบบและปรับใหเ้หมาะสมและตรงกบัลกัษณะท่ีวางไวม้ากท่ีสุด  
 

 
 
 
 
 
 
 
 

 
รูปที ่3.4 ภาพตวัอยา่งตวัละครเด็กผูช้ายและเด็กผูห้ญิง 

 
 
 
 
 
 
 
 
 
 

รูปที ่3.5 ภาพตวัอยา่งสัตวว์เิศษหลายๆแบบ 
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รูปที ่3.6 ภาพตวัอยา่งสัตวท์ะเล และสัตวป่์า 
 

ในส่วนของฉากจะออกแบบใหส้ัมพนัธ์กบัตวัละครสัตวม์ากท่ีสุด เช่น สัตวท์ะเล จะตอ้งออกแบบฉาก
ให้อยู่ในทอ้งทะเล และสัตวป่์าก็ตอ้งออกแบบฉากป่า ให้เหมาะสมกบัสัตวม์ากท่ีสุด ขั้นตอนการท า
คล้ายกับการออกแบบตัวละครโดยเร่ิมจากร่างฉากคร่าวๆ หลายๆแบบ จากนั้นคัดเลือกฉากท่ี
เหมาะสมท่ีสุด น ามาปรับปรุงและเพิ่มเติมรายละเอียดในฉากใหช้ดัเจนดงัรูปท่ี 3.7 
 
 
 
 
 

 
 

รูปที ่3.7 ภาพฉากทะเล และฉากทะเลปรับปรุงแลว้ 
 

6) ศึกษาโคด้โปรแกรมม่ิง ซ่ึงภาษาท่ีใชคื้อ แอคชัน่สคริป 3.0 โดยทดลองเขียนโคด้จ าลอง ท่ี
มีการสร้างรูปภาพอย่างง่ายๆ ข้ึนมาก่อนและหัดเขียน าความเช้าใจกบัภาษาสคริป และคิดหาวิธีท า
เพื่อให้ไดต้รงตามแผนภาพล าดบัเหตุการณ์ของเกมน้ี ในการศึกษาโคด้ เน่ืองจากแอคชัน่สคริป 3.0 
เป็นภาษาท่ีมีความซบัซ้อนมาก หนงัสือภาษาไทยท่ีตีพิมพอ์อกมาจะมีแค่ตวัอยา่งให้หดัท าแลว้ศึกษา
โคด้จากตวัอยา่งง่ายๆ เท่านั้น ผูจ้ดัท าโครงงานจึงตอ้งหาขอ้มูลเพิ่มเติมเองจากเวปไซต ์และหนงัสือ
ภาษาองักฤษแทน 
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7) การเขียนบทและการบนัทึกเสียง ในการเขียนรายละเอียดบทพูดของตวัละคร โดยอา้งอิง
จากล าดบัเหตุการณ์ท่ีคิดไวใ้นแผนภาพล าดบัเหตุการณ์ประกอบดว้ย บทบรรยายเน้ือเร่ืองของเกม ซ่ึง
ในเกมน้ีจะเป็นการบรรยายโดยใชต้วัอกัษร ผูเ้ล่นจะตอ้งใชก้ารอ่านตลอดทั้งเกม ยกเวน้ในส่วนของ
เน้ือเร่ืองก่อนเขา้เกมส่วนของการใหค้วามรู้เร่ืองสัตว ์และสมุดบนัทึกเท่านั้นท่ีจะมีการพากยเ์สียง โดย
การคดัเลือกนกัพากยแ์ลว้น าบทละครท่ีไดม้าซอ้มพดู เพื่อใหคุ้น้ชินกบับทก่อน  
 
3.3.1.2 ข้ันตอนการสร้างงาน (Production) 
 1)  วาดและลงสีตวัละคร ใหน้ าภาพท่ีวาดเสร็จสมบูรณ์ในกระดาษน ามาเขา้เคร่ืองสแกนเนอร์ 
จากนั้นน าไฟลท่ี์สแกนไดม้าดราฟ (draft) ซ่ึงในโปรแกรมอะโดบี อิลลสัสเตเตอร์ ซีเอสห้า ให้ไดภ้าพ
กราฟิกส์แบบเวกเตอร์ และท าการแยกเลเยอร์ ช้ินส่วนต่างๆ ของตวัละครออกเป็นชั้นๆ เพื่อสะดวกต่อ
การน าไปท าภาพเคล่ือนไหวและลงสีดงัรูปท่ี 3.8 
 

 
 
 
 
 

 
 
 

รูปที ่3.8 ภาพตวัละครเด็กผูห้ญิงท่ีแยกช้ินส่วน 
 

เม่ือได้ภาพท่ีเป็นโครงร่างแล้วน าไปลงสี ในขั้นตอนของการลงสีให้กับตัวละครนั้นทางผูจ้ดัท า
โครงงานได้ก าหนดการลงสีของตวัละครให้มีความเหมาะสม กบักลุ่มตวัอย่างโดยสีท่ีใช้ลงกบัตวั
ละครท่ีเป็นสัตว ์จะเนน้สีสดใสและเลือกสีให้เหมาะสมกบัลกัษณะเฉพาะของสัตวช์นิดนั้น ส่วนการ
เลือกสีตวัละครหลกั จะเลือกสีตามความเหมาะสมกบับุคลิกของตวัละคร และใชเ้ทคนิคของการไล่
เฉดสีเพื่อใหต้วัละครมีมิติมากข้ึน ซ่ึงตวัละครเด็กผูห้ญิงนั้น สีท่ีเลือกใชคื้อ สีชมพอู่อนท่ีมีการไล่เฉดสี 
ซ่ึงสีชมพนูั้นเป็นสีท่ีแทนสัญลกัษณ์ของเด็กผูห้ญิงดงัรูปท่ี 3.9 
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รูปที ่3.9 ภาพตวัละครเด็กผูห้ญิงท่ีลงสีแลว้ 

 
ต่อไปเป็นขั้นตอนของการก าหนดทิศทางของแสง  ผูจ้ดัท าโครงงานไดก้ าหนดวา่ทิศทางแสงของตวั
ละครกบัฉากท่ีตวัละครตวันั้นอยู ่ตอ้งมีทิศทางไปในลกัษณะเดียวกนั ในส่วนของการเพิ่มแสงและเงา
น้ีจะท าให้ตวัละครมีรายละเอียดท่ีชัดเจนมากข้ึน ส่วนการเลือกสีของแสงและสีของเงานั้น ผูจ้ดัท า
โครงงานไดท้  าการสร้างตารางแบ่งล าดบัสี เพื่อสะดวกต่อการลงแสงและเงามากยิ่งข้ึน ในการเลือกสี
ของแสงและสีของเงานั้น จะเร่ิมจากสีหลกัก่อน จากนั้นสีของแสงและสีของเงายงัคงใช้สีเดิมแต่ใช้
เทคนิคของ Blending Mode และ Opacity ในการปรับค่าสีให้เขม้ข้ึน และอ่อนลงตามล าดบั ท าให้สี
ของเงา และสีหลกักลมกลืน แต่ยงัอยูใ่นโทนเดียวกนั ในการลงสีตวัละครบางตวั เพียงแค่ลงสีของเงา
ก็เพียงพอแลว้ ไม่จ  าเป็นตอ้งมีสีแสง ข้ึนอยูก่บัความเหมาะสมและองคป์ระกอบของฉากดงัรูปท่ี 3.10 

 
 

 
 
 
 
 
 
 

 
รูปที ่3.10 ภาพตวัละครเด็กผูห้ญิงท่ีลงแสงเงาแลว้ 
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 2) วาดและลงสีฉาก ซ่ึงขั้นตอนของการวาด และลงสีฉากเหมือนกบัขั้นตอนของการวาด และ
ลงสีตวัละคร ต่างกนัท่ี ฉากจะแยกเลเยอร์บางส่วนโดยจะแยกช้ินส่วนประกอบฉากท่ีตอ้งการขยบั
ออกมา ซ่ึงในการเลือกช้ินส่วนนั้นทางผูจ้ดัท าโครงงานจะเป็นผูก้  าหนดวา่จะให้ส่ิงใดเคล่ือนไหวได้
บา้งโดย เร่ิมคิดตั้งแต่ในขั้นตอนน้ี ส่วนท่ีไม่มีการขยบัจะถูกปรับภาพให้เป็นภาพ Image เพื่อประหยดั
พื้นท่ีในการเก็บขอ้มูล โดยการเลือกภาพท่ีตอ้งการและไปท่ี Object > Rasterize และเลือก Resolution 
เป็น screen (72ppi) ซ่ึงเป็นการปรับภาพใหอ้ยูใ่นขนาดเท่าหนา้จอมาตรฐาน เม่ือปรับเป็นรูปภาพแบบ
น้ีแลว้ ภาพเหล่าน้ีจะไม่สามารถขยายหรือลดขนาดได ้เพราะถา้ท าการปรับขนาดภาพจะแตก ดงันั้นจึง
ตอ้งคิดและวางแผนก่อนท่ีจะท าต่อไป 

 
 

 
 
 
 
 

 
รูปที ่3.11 ภาพฉากทะเลก่อนลงสี 

 
 
 
 
 
 
 

 
รูปที ่3.12 ภาพฉากทะเลหลงัลงสี 

 
 3) การเคล่ือนไหวตวัละคร เม่ือท าการลงสีของตวัละครและฉากเสร็จแลว้ให้เปิดโปรแกรมอะ
โดบี แฟลช ซีเอสหา้ และสร้างไฟลข้ึ์นมาใหม่ โดยเลือก Action Script 3.0 ดงัรูปท่ี 3.13  
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รูปที ่3.13 ภาพเปิดโปรแกรมอะโดบี แฟลช ซีเอสหา้ และเลือก Action Script 3.0 
 

จากนั้นก าหนดขนาดของเกม ซ่ึงผูจ้ดัท าไดก้ าหนดขนาดอยูท่ี่ 800 × 600 pixel และอตัราของการ
แสดงเคล่ือนไหว (Frame Rate) อยูท่ี่ 20 เฟรม ซ่ึงเป็นขนาดมาตรฐานของเกมแฟลซและสามารถเปิด
ไดก้บัคอมพิวเตอร์ทุกรุ่น ดงัรูปท่ี 3.14 
 
 
 
 
 
 
 
 

รูปที ่3.14 ภาพเปิดโปรแกรมอะโดบี แฟลช ซีเอสหา้ และตั้งค่าหนา้กระดาษ 
 

น าภาพทั้งหมดท่ีวาดไวเ้ขา้มา โดยคล๊ิกไปท่ี File > Import > Import to Stage วธีิดงักล่าวจะท าใหไ้ฟล์
ภาพท่ีมีขนาดและต าแหน่งไม่เปล่ียนแปลงไปจากเดิม ดงัรูปท่ี 3.15 
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รูปที ่3.15 ภาพฉากหลกัของเกม เม่ือน าเขา้โปรแกรมอะโดบี แฟลช ซีเอสหา้ 
 

เม่ือน าภาพฉากหลกัเขา้มาแลว้ ท าการก าหนดในส่วนของการปฏิสัมพนัธ์ ซ่ึงจะน ารูปภาพ มาสร้าง
เป็นซิมโบล์ (symbol) โดยเลือกท่ีรูปภาพ ให้ไปท่ี Modify > Convert to symbol… ตั้งช่ือรูปภาพ ดงั
รูปท่ี 3.16 

 
 
 
 
 

 
รูปที ่3.16 ภาพฉากหลกัของเกม เม่ือท าการสร้างเป็นซิมโบล ์

 
จากนั้นเลือกชนิดการเก็บเป็น ปุ่ม (Button) จากนั้นกดปุ่ม OK ภาพท่ีสร้างน้ีจะถูกเก็บไวใ้นไลบราล่ี 
(Library)  เพื่อสะดวกแก่การน าไปใชซ้ ้ า และโคด้โปรแกรม นอกจากน้ียงัน าภาพท่ีเก็บไวม้าใชก้บัเกม
ในฉากอ่ืนๆต่อไปไดด้งัรูปท่ี 3.17 
 
 
 
 
 

 
รูปที ่3.17 ภาพการเลือกชนิดของการสร้างซิมโบล ์
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ซ่ึงชนิด (Type) ของการเก็บท่ีแตกต่างกนั ดงัน้ี  
 1) มูฟวี่คลิป (Movie Clip) เป็นการเก็บรูปภาพให้ลกัษณะของการเคล่ือนไหวและง่ายต่อ
การน ามาโคด้โปรแกรม ถา้น าตวัละครมาสร้างและเก็บอยูใ่นรูปแบบน้ี ภาพท่ีไดท้  าการขยบั ทั้งหมด
จะสามารถวนซ ้ าๆ ก่ีรอบก็ได ้เช่น สัตวว์ิเศษเดิน ก็ท  าการเคล่ือนไหวของการเดินในส่วนของการยก
แขนขา แค่ 1 รอบ เท่านั้น ตวัโปรแกรมจะสั่งใหต้วัละครเดินซ ้ าๆเองดงัรูปท่ี 3.18 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.18 ภาพการเคล่ือนไหวการเดินของสัตวว์เิศษในรูปแบบของมูฟวีค่ลิป  
 

 2) ปุ่ม (Button) เป็นการเก็บรูปภาพชนิดปุ่ม ผูเ้ล่นสามารถจะกดท่ีภาพน้ีเพื่อใหเ้กิดการ 
ปฏิสัมพนัธ์อ่ืนๆ เช่น การลิงคเ์ช่ือมไปหนา้อ่ืน หรือมีเหตุการณ์ต่างๆเกิดข้ึนดงัรูปท่ี 3.19 
 
 
 
 
 
 
 
 

รูปที ่3.19 ภาพการสร้างปุ่ม  
 
 3) รูปภาพกราฟิกส์ (Graphic) ภาพประเภทน้ีเหมาะท่ีจะน ามาท าภาพเคล่ือนไหวและเก็บ
ภาพท่ีตอ้งใชเ้ท่านั้น แต่ไม่สามารถท่ีจะตั้งช่ือเพื่อน าไปโคด้โปรแกรมได ้ 
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เม่ือก าหนดภาพเป็นซิมโบล ์แลว้ ต่อมาก็ท าการขยบัภาพเพื่อใหเ้กมมีความน่าสนใจและดึงดูดมากข้ึน 
โดยการเพิ่ม คียเ์ฟรม (Key Frame) ใหก้ด (F5) ลงใน ไทมไ์ลน์ (Timeline) เพื่อสร้างการเคล่ือนไหวที
ละเฟรม (Frame) ดงัรูปท่ี 3.20 

 
 
 
 
 
 
 
 
 
 

รูปที ่3.20 ภาพฉากหลกัของเกม ท่ีท าการเคล่ือนไหวแลว้ 
 
เม่ือก าหนดเป็นซิมโบล์ และท าการขยบัภาพเสร็จหมดแลว้ จะท าการใส่โคด้แอคชัน่สคริป (Action 
Script) เพื่อเป็นตวัลิงคเ์ช่ือมโยงไปหนา้อ่ืน โดยการเพิ่มเลเยอร์ข้ึนมาใหม่ และตั้งช่ือวา่ “as” จากนั้น
ไปท่ี Windows > Actions ดงัรูปท่ี 3.21 

 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.21 ภาพการสร้างโคด้แอคชัน่สคริป 



41 
 

 

ท าการโคด้โปรแกรม โดยการประกาศตวัแปร และอา้งอิงช่ือตวัแปรเช่ือมกบัรูปภาพท่ีไดก้ าหนดเป็น
ซิมโบลไ์วแ้ลว้เขา้ดว้ยกนัดงัรูปท่ี 3.22 
 
 
 
 
 
 
 
 
 
 
 
 

รูปที ่3.22 ภาพตวัอยา่งโคด้แอคชัน่สคริป 
 

ในส่วนของเกมการผจญภยัในแต่ละเกาะ ผูเ้ล่นจะตอ้งเขา้ไปสู่หนา้หลกัของเกาะ ก่อนท่ีจะเขา้สู่ทอ้ง
ทะเลโดยการ สร้างซิมโบล์และเลือกชนิดเป็น Button เพื่อเช่ือมจากหนา้หลกัของทอ้งทะเล ลงไปใน
ทะเล ตวัอยา่งเช่น เกาะแห่งทอ้งทะเลดงัรูปท่ี 3.23 จะมีขอ้ความสัญลกัษณ์ปรากฏข้ึนเป็นจุดสังเกต 
เพื่อใหผู้เ้ล่นไดส้ ารวจ 

 
 
 
 
 
 
 
 
 
 

รูปที ่3.23 ภาพตวัอยา่งหนา้หลกัของเกาะแห่งทอ้งทะเล 
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รูปที ่3.24 ภาพตวัอยา่งฉากยาวของทอ้งทะเล 
 

จากรูปท่ี 3.24 เป็นฉากยาวของทอ้งทะเล การจะท าให้ตวัละครและฉากเคล่ือนท่ีไปไดน้ั้นตอ้งเขียน
โคด้ โดยการน าขนาดของฉาก (4054×664 pixel) มาเขา้เง่ือนไข (if…else) เช็คแยกแกน X และแกน Y 
จากนั้นใชฟั้งกเ์ช็คชนครอบเง่ือนไขน้ีอีกคร้ัง เพื่อให้ฉากเล่ือนเม่ือตวัละครมีการเคล่ือนท่ี และเพื่อเกิด
ความสมจริงมากข้ึน ผูจ้ดัท าไดเ้พิ่มในส่วนของการเช็คชนกอ้นหิน เม่นทะเล และสมอ เม่ือตวัละคร
ถูกสมอเรือ หรือเม่นทะเล จะมีเสียงเตือนและพลงัชีวติของสัตวว์เิศษจะลดลง  
 
 
 
 
 
 
 
 
 

 
รูปที ่3.25 ภาพตวัอยา่งสัตวท่ี์ตอ้งรวบรวมรู้จากฉากผนืป่า 

 
จากรูปท่ี 3.25 ในส่วนของการรวบรวมความรู้ ผูเ้ล่นจะตอ้งรวบรวมความรู้จากสัตวท่ี์ไดช่้วยเหลือมา
โดยการคล๊ิกไปท่ีตวัสัตว ์จากนั้นจะมีใบความรู้ข้ึนมาเม่ือผูเ้ล่นกดปุ่ม จะมีเน้ือหาปรากฏข้ึนพร้อม
เสียงบรรยายประกอบ ดงัรูป 3.26 
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รูปที ่3.26 ภาพตวัอยา่งใบความรู้ท่ีตอ้งรวบรวมจากสัตว ์
 
ในส่วนของการบนัทึกขอ้มูล ผูจ้ดัท าไดอ้อกแบบระบบบนัทึกขอ้มูลให้มีการบนัทึกแบบอตัโนมติั 
และระบบสามารถบนัทึกได ้2 บญัชี โดยผูเ้ล่นจะสามารถจดัการกบัขอ้มูลแต่ละบญัชีขอ้มูลไดอ้ยา่ง
สะดวก การบนัทึกขอ้มูลของเกมน้ีจะใชก้ารสร้างอ็อบเจคแบบใชร่้วม (Shared Object) โดยผูจ้ดัท าจะ
สร้างอ็อบเจคข้ึนมาช้ินหน่ึง เพื่อบันทึกข้อมูลเก็บไวใ้นเคร่ืองของผูเ้ล่น ซ่ึงข้อมูลท่ีบันทึกจะมี
นามสกุล .sol ท่ีตวั Flash Player สร้างข้ึน ในขณะท่ีโปรแกรมแฟลซนั้นมีหน้าท่ีเขียนค าสั่งและ
เรียกใชง้าน ดงันั้นผูใ้ชง้านไม่จ  าเป็นตอ้งมีโปรแกรมแฟลซอยูบ่นเคร่ืองก็ได ้เพียงแค่มี Flash Player ก็
จะสามารถเล่นไดไ้ฟล.์sol โดยขอ้มูลทั้งหมดถูกบนัทึกลงในเคร่ืองคอมพิวเตอร์อยูท่ี่ C : \ Documents 
and Settings \ Username \ Application Data \ Macromedia \ Flash Player \ #SharedObjects หรืออาจ
แตกต่างกนัไปตามแต่ระบบของเคร่ืองผูใ้ชง้าน 
 
ระบบบนัทึกขอ้มูล แบ่งออกเป็น 2 ส่วน คือ ส่วนอ่านขอ้มูลและส่วนบนัทึกค่า ในส่วนของการอ่านค่า
ขอ้มูลไดเ้ขียนโคด้ควบคุมโดยอยูใ่นหนา้เลือกตวัละคร แต่ส่วนของการบนัทึกค่าจะเขียนโคด้แทรกอยู่
ในการเดินทางของตวัละครหลงัจากท่ีผา่นภาระกิจของแต่ละเกาะไดส้ าเร็จ 
 
การบนัทึกขอ้มูลในส่วนของการอ่านขอ้มูล ท าหน้าท่ีตรวจสอบขอ้มูลท่ีได้บนัทึกค่าไวแ้ล้ว ซ่ึงจะ
แสดงผลของขอ้มูลไดท้ั้ง 2 บญัชี อีกทั้งสามารถควบคุมการท างานของปุ่มต่างๆ ในหนา้เลือกตวัละคร 
สามารถแสดงแผนล าดบังานไวใ้นรูปท่ี 3.27 
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รูปที ่3.27 ภาพแผนผงัล าดบังาน อธิบายการท างานของระบบบนัทึกขอ้มูลส่วนอ่านขอ้มูล 
 

หลกัการท างานของโคด้โปรแกรมท่ีควบคุมระบบบนัทึกขอ้มูลส่วนอ่านขอ้มูล มีลกัษณะส าคญั ดงัน้ี 
1) มีตวัแปรออ็บเจกตแ์บบใชร่้วมทั้งหมด 2 ตวั เพื่อแยกเก็บขอ้มูลของผูเ้ล่น 
2) เม่ือผูเ้ล่นเขา้มาในส่วนของ Start Game ก็จะมีการเรียกใชอ้็อบเจคแบบใช้ร่วม เพื่อ

ตรวจสอบขอ้มูลท่ีบนัทึกไว ้
3) ตรวจสอบวา่มีขอ้มูลถูกบนัทึกไวใ้นตวัแปรออ็บเจคแบบใชร่้วม เพื่อใชเ้ป็นเง่ือนไขให้

สามารถเร่ิมเกมได ้
4) มีปุ่ม Delete ไวเ้พื่อลบขอ้มูลในบญัชีโคด้โปรแกรมของระบบบนัทึกขอ้มูลส่วนบนัทึก

ค่า คือ การบนัทึกข้อมูลหลงัจากท่ีผูเ้ล่นท าภาระกิจของแต่ละเกาะได้ส าเร็จ ข้อมูลก็จะถูกบนัทึก 
สามารถแสดงไดด้งัรูปท่ี 3.28 
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รูปที ่3.28 ภาพแผนผงัล าดบังาน อธิบายการท างานของระบบบนัทึกขอ้มูลส่วนบนัทึกค่า 
 
หลกัการท างานของโคด้โปรแกรมท่ีควบคุมระบบบนัทึกขอ้มูลส่วนบนัทึกค่า มีลกัษณะส าคญั ดงัน้ี 

1) ก าหนดตวัแปรท่ีใชบ้นัทึกไว ้2 ตวั  
2) ก าหนดค่าตวัแปรท่ีจะบนัทึกใหส้ัมพนัธ์กบัต าแหน่งของผูเ้ล่น 
3) ค่าท่ีบนัทึกในตวัแปรจะเป็นตวัอา้งอิงในเวลาท่ีผูเ้ล่นกลบัมาเล่นอีกคร้ัง เพื่อให้เล่นต่อ

จากท่ีเดิมได ้
 
เม่ือท าการขยบัตวัละครใหเ้คล่ือนไหวแลว้ และโคด้โปรแกรมทั้งหมดเสร็จ ขั้นตอนสุดทา้ยคือการใส่
เสียงลงไปในเกมเพื่อเพิ่มความสมจริงและความสนุกมากยิ่งข้ึน โดยเสียงท่ีเลือกข้ึนอยู่กับความ
เหมาะสมของฉาก และตวัละครน าเสียงท่ีตอ้งการมาปรับแต่งโดยผา่นโปรแกรมซาวด์ฟอร์ด ออดิโอ 
สตูดิโอ 9.0 ตดัเสียงบางส่วนท่ีไม่ตอ้งการออก และ Save เป็นไฟล์ .wav เพราะไฟล์ .wav มีขนาดเล็ก
และน าไฟล์เสียงนั้นเขา้ โปรแกรมแฟลซ โดยคล๊ิกไปท่ี File > Import > Import to Library… เพื่อน า
ไฟล์เสียงเก็บไวใ้น ไลบราล่ี ซ่ึงไฟล์เสียงท่ีน าเขา้มาน้ีมี 2 แบบ คือ เสียงดนตรี (BGM) และเสียงเอฟ
เฟกซ์ (Sound Effect) เสียงดนตรีจะก าหนดช่ืออา้งอิงและท าการใส่เสียงผา่นโคด้วิธีน้ีจะควบคุมเสียง
ไดง่้ายกวา่การใส่เสียงลงไปในเฟรมโดยตรง เพราะเสียงดนตรี เป็นท านองยาว ส่วนเสียงเอฟเฟกซ์จะ
ใส่ไปในปุ่มต่างๆ เพราะเสียงสั้น  
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รูปที ่3.29 ภาพไฟลเ์สียงท่ีน ามาเก็บไวใ้นไลบราล่ี 
 
 
 
 

 
รูปที ่3.30 ภาพการน าเสียงดนตรีมาใส่โดยใชโ้คด้ 

 
 

 
 
 

รูปที ่3.31 ภาพการใส่เสียงเอฟเฟกซ์กบัปุ่ม 
 

3.3.1.3  ข้ันตอนหลงังานเสร็จสมบูรณ์ (Post - Production) 
 1)  การทดสอบเกมผจญภยั 2 มิติ ตรวจสอบขอ้ผิดพลาดต่างๆ ของเกม เช่น ความถูกตอ้งของ
เน้ือหา ตวัอกัษร ระดบัเสียง การควบคุมตวัละคร และการเคล่ือนไหว เพื่อน าไปปรับปรุงแกไ้ข 
 2)  ปรับปรุงขอ้บกพร่อง น าขอ้ผิดพลาดท่ีพบโดยการน าไปทดสอบกบั ผูใ้ช ้(User) ก่อนและ
น าค าแนะน า มาปรับปรุงแกไ้ขเพิ่มเติม เพื่อใหเ้กมมีประสิทธิภาพมากท่ีสุด 
 3) ขอ้จ ากดัของเกมน้ี เน่ืองจากเกมน้ีเป็นเกมท่ีออกแบบมาให้ ผูเ้ล่นด าเนินเน้ือเร่ืองตามท่ีเกม
ก าหนดไว้เท่านั้ น ระยะเวลาในการเล่นเกมค่อนข้างสั้ นและเกมจบในตัว อีกทั้ งภาพและการ
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เคล่ือนไหวอาจจะมีการกระตุกหรือชา้ไปบา้งเน่ืองจากไฟล์ภาพท่ีน าเขา้มาส่วนใหญ่เป็นภาพเวกเตอร์
ท่ีมีหลายเลเยอร์ ซ้อนกนัจ านวนมากท าให้การโหลดไฟล์ในแต่ละฉากจะช้า ขณะเล่นเกมถา้เกิดการ
ติดขดัหรือไปต่อไม่ได ้ให้ปิดและเปิดใหม่ เพราะเกมน้ีมีการใช้ภาพประกอบกบัการโคด้โปรแกรม
เยอะเป็นส่วนใหญ่อาจจะท าให้เกมรวน สุดทา้ยเกมน้ีผูเ้ล่นจะตอ้งลง Flash Player เอาไว ้เพราะเกมน้ี
ใชน้ามสกุล .swf ในการเล่นเกม 
 

3.3.2 ขั้นตอนการสร้างแบบประเมนิคุณภาพส าหรับผู้เช่ียวชาญ 
เคร่ืองมือท่ีใชส้ าหรับทดสอบหาคุณภาพของเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วทิยาศาสตร์ เร่ือง 
สัตว ์ส าหรับเด็กอายุ 6–8 ปี ส าหรับผูเ้ช่ียวชาญ คือ แบบประเมินท่ีสร้างข้ึน ส าหรับผูเ้ช่ียวชาญดา้น
งานเกมและแอนิเมชัน่ จ  านวน 3 ท่าน โดยผลท่ีไดผู้จ้ดัท าโครงงานจะน ามาหาคุณภาพของเกมผจญภยั 
2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอายุ 6–8 ปี ในการออกแบบและการ
สร้างแบบประเมิน มีขั้นตอนดงัน้ี 

 
3.3.2.1 ศึกษาตัวอย่างแบบประเมิน 

ศึกษาแบบประเมินของผูอ่ื้นท่ีเป็นโครงงานท่ีใกลเ้คียงกนั คือ เกมผจญภยัล่าขุมทรัพย ์(เกมแฟลซการ
ตอบปัญหาความรู้รอบตวั) เพื่อเป็นแนวทางในการสร้างแบบประเมินของโครงงาน 
 
3.3.2.2 ก าหนดประเด็นทีจ่ะประเมิน 

การก าหนดประเด็นในการประเมินเพื่อเป็นแนวทางในการสร้างแบบประเมิน เพื่อให้ผลลพัธ์ของการ
ประเมินเป็นไปตามตอ้งการ ดงันั้นผูจ้ดัท าโครงงานจึงไดก้ าหนดประเด็นในการประเมินเกมผจญภยั 2 
มิติ เพื่อเสริมสร้างความรู้วทิยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอาย ุ6–8 ปี ออกเป็น 6 ดา้น ดงัน้ี 

 
ก.  ดา้นเน้ือหา 

 1)  ความเหมาะสมของเน้ือหากบัระดบัของเด็กอาย ุ6–8 ปี 
 2)  ความชดัเจนของเน้ือหา เขา้ใจง่าย 

 3)  ผูเ้ล่นไดรั้บความรู้วทิยาศาสตร์ เร่ือง สัตว ์

 4)  ความเหมาะสมของตวัอกัษรประกอบค าศพัท ์
 5)  ความต่อเน่ืองของล าดบัการน าเสนอเน้ือหา 

 6) ความน่าสนใจของเน้ือหาทบทวนความรู้ 
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ข.  ดา้นตวัละคร 
 1)  ความเหมาะสมของตวัละคร กบัเด็กอาย ุ6–8 ปี 

 2)  ความเหมาะสมของตวัละคร กบัเน้ือหา 

 3)  ความเหมาะสมของสีสันตวัละคร กบัเด็กอาย ุ6–8 ปี 

 4)  ความเหมาะสมของสัดส่วนตวัละคร กบัฉาก 

 5)  ความสอดคลอ้งของท่าทางตวัละครประกอบค าบรรยาย 

 
ค.  ดา้นฉาก 
 1)  ความเหมาะสมของฉาก กบัตวัละคร 

 2)  ความเหมาะสมขององคป์ระกอบฉาก กบัตวัละคร 

 3)  ความเหมาะสมของสีสันฉาก กบัเด็กอาย ุ6–8 ปี 

 
ง.  ดา้นการเคล่ือนไหว 

 1)  ความต่อเน่ืองของการเคล่ือนไหวตวัละคร 

 2)  ความต่อเน่ืองของการเคล่ือนไหวองคป์ระกอบฉาก 

 3)  ความเหมาะสมของการเคล่ือนไหว กบัการส่ือความหมาย 

 
จ.  ดา้นเสียง 

 1)  ความชดัเจนของเสียงพากย ์

 2)  ความชดัเจนของเสียงดนตรีประกอบ 

 3)  ความชดัเจนของเสียงพดูทบทวนค าศพัท ์

 4)  ความเหมาะสมของเสียงเอฟเฟกซ์ 

 5)  ความเหมาะสมของบทบรรยาย 

 
ฉ.  ดา้นภาพรวมของเกม 

 1)  ความเหมาะสมของระยะเวลาในการน าเสนอเกม กบัเด็กอาย ุ6–8 ปี 

 2)  ความเหมาะสมของการปฏิสัมพนัธ์ของเกม กบัเด็กอาย ุ6–8 ปี 

 3)  ความสามารถในการดึงดูดความสนใจของเกม ต่อเด็กอาย ุ6–8 ปี 
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3.3.2.3 ออกแบบแบบประเมิน 

ผูจ้ดัท าโครงงานไดส้ร้างค าถามเป็นแบบสอบถามความคิดเห็น ประกอบดว้ย 6 ประเด็น คือ เน้ือหา 
ตวัละคร ฉาก การเคล่ือนไหว เสียง และภาพรวมของเกม ก าหนดระดบัความคิดเห็นเป็น 5 ระดบัคือ ดี
มาก ดี ปานกลาง น้อย และน้อยท่ีสุด ซ่ึงใช้ประเมินคุณภาพโดยผูเ้ช่ียวชาญ นอกจากน้ียงัมีพื้นท่ี
ส าหรับใหผู้เ้ช่ียวชาญใส่ความคิดเห็นเพิ่มเติมดว้ย 

  
3.3.2.4 ให้อาจารย์ทีป่รึกษาตรวจสอบ 

เม่ือท าการร่างแบบประเมินเสร็จ น าส่งให้อาจารยท่ี์ปรึกษาโครงงานตรวจสอบ เพื่อแกไ้ขให้ถูกตอ้ง 
และเหมาะสมมากท่ีสุด 

 
3.3.2.5 สร้างแบบประเมิน 

สร้างแบบประเมินในรูปแบบตาราง  เพื่อสะดวกในการอ่าน การวิเคราะห์และการให้คะแนนประเมิน
ของผูเ้ช่ียวชาญ (ภาคผนวกตาราง ค.) 
 

3.3.3 ขั้นตอนการสร้างแบบประเมนิพฒันาการส าหรับกลุ่มตัวอย่าง  
แบบประเมินพฒันาการสร้างข้ึนเพื่อประเมินวา่ เกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ 
เร่ือง สัตว ์ส าหรับเด็กอาย ุ6–8 ปี ช่วยส่งเสริมการเรียนรู้วทิยาศาสตร์ได ้ซ่ึงมีขั้นตอนดงัน้ี 
 

3.3.3.1 ปรึกษาอาจารย์ทีป่รึกษา 
ปรึกษาอาจารยเ์ก่ียวกบัรูปแบบของการประเมินท่ีเหมาะสมกบัลกัษณะของกลุ่มตวัอย่าง จะมีการ
ประเมิน โดยใช้แบบทดสอบความรู้ เพื่อประเมินพฒันาการดา้นความรู้วิทยาศาสตร์ เร่ือง สัตว ์กบั
กลุ่มตวัอยา่ง ก่อนเล่นเกม และในระหวา่งเล่นเกมจะมีการแทรกแบบทดสอบความรู้ลงไปในเกมเพื่อ
สะดวกแก่การเก็บขอ้มูล  นอกจากน้ีจะมีการประเมินความพึงพอใจต่อเกม โดยผูจ้ดัท าโครงงานจะ
เป็นผูอ้ธิบายและควบคุมการประเมินในคร้ังน้ี 
 
3.3.3.2 ออกแบบแบบประเมิน 
แบบทดสอบความรู้วิชา วิทยาศาสตร์ เร่ือง สัตว ์จะมีลกัษณะเป็นขอ้สอบโดยแบ่งออกเป็น 2 หวัขอ้ 
คือ สัตวน์ ้ า และสัตวป่์า  หวัขอ้ละ 7 ขอ้ รวมทั้งส้ิน 14 ขอ้ ซ่ึงแต่ละขอ้จะมี 3 ตวัเลือก ซ่ึงใชป้ระเมิน
พฒันาการของกลุ่มตวัอยา่ง  
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3.3.3.3 สร้างแบบประเมิน 

สร้างแบบทดสอบความรู้ ท่ีมีลกัษณะเป็นขอ้สอบ เพื่อให้ง่าย และสะดวก ในการวิเคราะห์และการให้
คะแนนของผูจ้ดัท าโครงงาน (ภาคผนวก ง.) 
 

3.3.4 ขั้นตอนการสร้างแบบประเมนิความพงึพอใจส าหรับกลุ่มตัวอย่าง  
เคร่ืองมือท่ีใช้ส าหรับหาความพึงพอใจของกลุ่มตวัอย่างคือ  แบบประเมินท่ีสร้างข้ึน (ภาคผนวก จ.) 
ซ่ึงใชก้บักลุ่มตวัอยา่งจ านวน 10 คน และผลท่ีไดจ้ะน ามาหาความพึงพอใจท่ีผูช้มท่ีมีต่อเกมผจญภยั 2 
มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอายุ 6–8 ปี การออกแบบและสร้างแบบ
ประเมินผูจ้ดัท าโครงงานไดจ้ดัใหมี้ขั้นตอนดงัน้ี 

 
3.3.4.1 ปรึกษาอาจารย์ทีป่รึกษา 

อาจารยใ์หค้  าแนะน าวา่ แบบประเมินควรเป็นค าถามท่ีเขา้ใจง่าย และมีจ านวนขอ้ไม่มากเกินไป 

 
3.3.4.2 ก าหนดประเด็นทีจ่ะประเมิน 

ก าหนดประเด็นเพื่อเป็นแนวทางในการสร้างแบบประเมิน ซ่ึงหัวขอ้ในการประเมินโครงงาน ไดแ้ก่ 
ดา้นเกม ตวัละคร ฉาก ภาพเคล่ือนไหว ตวัอกัษรเสียงประกอบ สาระความรู้ และ ความตอ้งการเล่นซ ้ า 

  

3.3.4.3 ออกแบบแบบประเมิน 

แบบประเมินใชล้กัษณะการบอกหวัขอ้ และให้ตวัเลือก เพื่อให้ง่าย สะดวก และรวดเร็วในการบนัทึก
ขอ้มูล 

 
3.3.4.4 สร้างแบบประเมิน 

สร้างแบบประเมินตามท่ีไดอ้อกแบบไว ้โดยเนน้ใหก้รอกขอ้มูลตามความเป็นจริง 

 

3.4 วธีิการรวบรวมข้อมูล 

 

3.4.1 คุณภาพงาน เกมผจญภัย 2 มติิ เพือ่เสริมสร้างความรู้วทิยาศาสตร์ เร่ือง สัตว์ ส าหรับ
เด็กอายุ 6–8 ปี 
 

ประเมินแบบประเมินคุณภาพท่ีเสร็จสมบูรณ์ โดยผูเ้ช่ียวชาญจ านวน 3 ท่านซ่ึงเป็นผูเ้ช่ียวชาญท่ี
ทรงคุณวฒิุท่ีมีความเช่ียวชาญโดยตรงซ่ึงการรวบรวมขอ้มูลจากผูเ้ช่ียวชาญ มีขั้นตอนดงัต่อไปน้ี 
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 1) ท าการติดตั้งเกมท่ีสร้างข้ึนลงบนคอมพิวเตอร์ให้เรียบร้อยพร้อมท่ีจะท าการแสดง 
 2) เชิญผูเ้ช่ียวชาญ  เพื่อท าการประเมินคุณภาพของเกมผจญภยั 2 มิติ ท่ีสร้างข้ึน 

 3) อธิบายรายละเอียดของเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์
ส าหรับเด็กอาย ุ6–8 ปี  

4) ผูเ้ช่ียวชาญท าการประเมินคุณภาพของเกมผจญภยั ตามแบบประเมินท่ีไดอ้อกแบบซ่ึงการ
ประเมินจะใชก้ารเลือกระดบัความคิดเห็นทั้ง 5 ระดบั ซ่ึงข้ึนอยูก่บัความคิดเห็นของผูเ้ช่ียวชาญ และ
แสดงความคิดเห็นเพิ่มเติม 

 5) เก็บรวบรวมแบบประเมินท่ีไดจ้ากการประเมิน เพื่อท่ีจะน ามาวเิคราะห์ผลลพัธ์ต่อไป 

 

3.4.2 พฒันาการของกลุ่มตัวอย่าง  
ผูถู้กประเมินเป็นประชากรนกัเรียนระดบัชั้นประถมศึกษาปีท่ี 1–3 โรงเรียนนาหลวง ใช้วิธีการเลือก
ตวัอยา่งแบบเจาะจง (Purposive Sampling) มีขั้นตอนดงัต่อไปน้ี 

1)  ติดต่อประสานงานกบัทางโรงเรียนในดา้นจดัหาสถานท่ีและอุปกรณ์ 

2)  ประเมินพฒันาการก่อนเล่นเกม โดยใช้แบบทดสอบความรู้ทางวิทยาศาสตร์ ซ่ึงเป็น
แบบทดสอบแบบเลือกตอบ 3 ตวัเลือก จ านวน 14 ขอ้ ในการประเมินกลุ่มตวัอยา่ง 

3)  ให้กลุ่มตวัอยา่งไดเ้ล่น เกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์
ส าหรับเด็กอาย ุ6–8 ปี 

4) ประเมินพฒันาการหลงัเล่นทนัที โดยใชว้ธีิการเหมือนตอนประเมินคร้ังแรก 
5)  เก็บรวบรวมแบบประเมินท่ีไดจ้ากการประเมินแลว้เพื่อท่ีจะน ามาวเิคราะห์ผลต่อไป 

 

3.4.3 ความพงึพอใจของกลุ่มตัวอย่าง  
ผูถู้กประเมินเป็นประชากรนกัเรียนระดบัชั้นประถมศึกษาปีท่ี 1–3 โรงเรียนนาหลวง ใช้วิธีการเลือก
ตวัอยา่งแบบเจาะจง (Purposive Sampling) มีขั้นตอนดงัต่อไปน้ี 

1) ติดต่อประสานงานกบัทางโรงเรียนนาหลวงในดา้นจดัหาสถานท่ีและอุปกรณ์ 

2) ประเมินความพึงพอใจของกลุ่มตวัอยา่ง หลงัจากประเมินพฒันาการหลงัเล่นเกมทนัที 
3) เก็บรวบรวมแบบประเมินท่ีไดจ้ากการประเมินแลว้เพื่อท่ีจะน ามาวเิคราะห์ผลต่อไป 

 
 
 
 
 



52 
 

 

3.5 วธีิการวเิคราะห์ข้อมูล  

การวิเคราะห์ขอ้มูลจากการท าการประเมิน ผูจ้ดัท าโครงงานได้แบ่งการวิเคราะห์ขอ้มูลออกเป็น 3  
ส่วน  คือ การประเมินผลหาคุณภาพโดยให้ผูเ้ช่ียวชาญประเมินหาพฒันาการของกลุ่มตวัอย่างและ
ประเมินหาความพึงพอใจของกลุ่มตวัอยา่ง 

3.5.1 การวเิคราะห์หาคุณภาพของเกมผจญภัยของผู้เช่ียวชาญ 
 1) น าค าตอบท่ีไดจ้ากแบบประเมินคุณภาพโดยผูเ้ช่ียวชาญมาท าการวิเคราะห์โดย การแยก
เป็นแต่ละดา้น และท าการหาค่าเฉล่ีย 
 2) น าค่าเฉล่ียของแต่ละหวัขอ้ มาประเมินกบัเกณฑ์วดัผลท่ีไดต้ั้งข้ึนมา เพื่อประเมินคุณภาพ
ของเกมผจญภยั 2 มิติ เพื่อเสริมสร้างความรู้วิทยาศาสตร์ เร่ือง สัตว ์ส าหรับเด็กอายุ 6–8 ปี โดยเกณฑ์
วดัผลท่ีตั้งข้ึน ดงัน้ี 
 4.50 - 5.00 หมายถึง คุณภาพของเกมอยูใ่นระดบัดีมาก 
 3.50 - 4.49 หมายถึง คุณภาพของเกมอยูใ่นระดบัดี 
 3.00 - 3.49 หมายถึง คุณภาพของเกมอยูใ่นระดบัปานกลาง  
 1.50 - 2.49 หมายถึง คุณภาพของเกมอยูใ่นระดบัพอใช ้
 1.00 - 1.49 หมายถึง คุณภาพของเกมอยูใ่นระดบัควรปรับปรุง 
 3) หาค่าเบ่ียงเบนมาตรฐานของแต่ละขอ้เพื่อมาวิเคราะห์หาความกระจายของขอ้มูลท่ีได ้
 4) น าค่าเฉล่ียท่ีไดม้าเทียบกบัเกณฑว์ดัผลท่ีตั้งข้ึน 
 5) เสนอขอ้มูลในรูปแบบตารางประกอบค าบรรยาย 
 

3.5.2 วเิคราะห์หาพฒันาการของกลุ่มตัวอย่าง 
 1) น าผลท่ีไดจ้ากแบบทดสอบความรู้ของกลุ่มตวัอยา่งมาหาค่าที (t-test) 

 2) เปรียบเทียบคะแนนก่อนและหลงัเรียนของนกัเรียนแต่ละคน  
 3) วเิคราะห์ผลท่ีได ้     
 4) เสนอขอ้มูลในรูปแบบตารางประกอบค าบรรยาย 
 

3.5.3 วเิคราะห์หาความพงึพอใจของกลุ่มตัวอย่าง 
 1) น าผลท่ีได้จากแบบประเมินความพึงพอใจของกลุ่มตวัอย่างมาหาเปอร์เซ็นต์ของแต่ละ
หวัขอ้  
 2) เปรียบเทียบเปอร์เซ็นตก่์อนและหลงัเรียนของแต่ละหวัขอ้  
 3) วเิคราะห์ผลท่ีได ้     
 4) เสนอขอ้มูลในรูปแบบตารางประกอบค าบรรยาย 
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3.6 สถติทิี่น ามาใช้วเิคราะห์  
จากการประเมินผลคุณภาพโดยผูเ้ช่ียวชาญ การประเมินผลพฒันาการของกลุ่มตวัอย่างและการ
ประเมินผลความพึงพอใจของกลุ่มตวัอยา่ง มีการน าสถิติมาใชใ้นการค านวณหาคุณภาพ ไดแ้ก่ การหา
ค่าเฉล่ียระดบัคะแนน การหาค่าเบ่ียงเบนมาตรฐาน และการค านวณหาร้อยละของจ านวนกลุ่มตวัอยา่ง
ในแต่ละหวัขอ้ โดยสูตรท่ีใชใ้นการค านวณ [23] เป็นดงัน้ี 
 

3.6.1 การหาค่าสถิติร้อยละ 

                                                         
100*P

n

f
  

 
 

 
 
 
3.6.2 การหาค่าเฉลีย่ 
    
 
    
 =  ค่าเฉล่ีย 
       f =  ค่าความถ่ี 
                           xi =  ระดบัคะแนน 
                                           n =  จ  านวนขอ้มูลทั้งหมด  
 
 
 
 
 
 
 
 

X

n

fxX
n
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i
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

 P     =  ค่าร้อยละ  
f  =  จ  านวนหรือความถ่ีของส่ิงท่ีตอ้งการ                      

ทราบค่าร้อยละ  
n  =  จ  านวนขอ้มูลทั้งหมด   
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3.6.3 การหาค่าเบี่ยงเบนมาตรฐาน 
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3.6.3 การหาค่าท ี
ในการทดสอบหาค่าที [24] ส าหรับประชากรสองกลุ่มท่ีมีความสัมพนัธ์กนั เป็นการทดสอบเพื่อ
ตอ้งการเปรียบเทียบคะแนนก่อนเล่น และหลงัเล่นเกมเป็นไปตามท่ีคาดหวงัไวห้รือไม่ โดยมีขอ้ตกลง 
ดงัน้ี 

1) กลุ่มตวัอยา่งไดม้าจากการสุ่ม (Random) 
2) ทราบความแปรปรวนของกลุ่มตวัอย่าง (S2) แต่ยงัไม่ทราบความแปรปรวนของ

ประชากร ( 2 ) และกลุ่มตวัอยา่งมีขนาดเล็ก (n < 30) 
3) การแจกแจงของประชากรเป็นโคง้ปกติ (Normal Distribution) 

ขั้นตอนในการทดสอบสมมติฐานเก่ียวกบัค่าเฉล่ียของประชากรกลุ่มเดียว โดยใชก้ารทดสอบค่าทีนั้น 
มีดงัต่อไปน้ี 
  3.1 ตั้งสมมติฐาน โดยใชก้ารทดสอบแบบสองทาง 
          H0   :  1      =    2   (เปรียบเทียบค่าคะแนนก่อนและหลงัเล่นเท่ากนั) 
          H1   :  1      ≠   2  (เปรียบเทียบค่าคะแนนก่อนและหลงัเล่นไม่เท่ากนั) 
 
 3.2 สถิติท่ีใชท้ดสอบ 

                                                       
n

S

d

d

t  

         
 
 
 

SD     =  ค่าเบ่ียงเบนมาตรฐาน  
 Xi  =  ระดบัคะแนน  
 n =  จ  านวนขอ้มูลทั้งหมด 

 df (v)      =  n - 1 
 d   =  ผลต่างของค่าเฉล่ีย  
 dS  =  ส่วนเบ่ียงเบนมาตรฐานผลต่างของกลุ่มตวัอยา่ง 
  n =  จ  านวนขอ้มูลทั้งหมด 
df หรือ (v) = ชั้นความเป็นอิสระ(Degree of Freedom) 
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3.3 ก าหนดระดบัความมีนยัส าคญัในการทดสอบสมมติฐาน (α) 
3.4 พิจารณาขอบเขตวิกฤตโดยจะปฏิเสธ H0 ส าหรับการทดสอบแบบสองทาง เม่ือค่า t ท่ี

ค  านวณไดม้ากกวา่หรือเท่ากบั tα/2(n-1) เปิดจากตารางหรือค่า t ท่ีค  านวณไดน้อ้ยกวา่หรือเท่ากบั -tα/2(n-1) 

ท่ีเปิดจากตาราง 
 
 
 
 
 
 
 

 
รูปที ่3.32 ภาพค่าที ท่ีค  านวณไดจ้ากการเปิดตาราง [24] 

 

n   

dd 

  d  =  ผลต่างของคะแนนก่อนเรียนและหลงัเรียน  
 d  =  ผลต่างของค่าเฉล่ีย 
  n =  จ  านวนขอ้มูลทั้งหมด 
 

 dS    =  ส่วนเบ่ียงเบนมาตรฐานผลต่างของกลุ่มตวัอยา่ง 
  di  =  ผลต่างคะแนนของนกัเรียนแต่ละคน  
  n =  จ  านวนขอ้มูลทั้งหมด 


